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Introduction 
 
This guide is for those who wish to start tagging their astronomical image collections with 
Astronomy Visualization Metadata (AVM) using the XMP standard. We are in the process of 
investigating and developing stand-alone (i.e., no Photoshop or Bridge) tools for tagging and 
embedding the XMP data into the header of an image. 
 
For more information on the projects: 
 
Virtual Astronomy Multimedia Project (VAMP): http://virtualastronomy.org 
AVM Version 1.1: http://virtualastronomy.org/avm_metadata.php  
 
 
Resources 
 
VAMP: http://virtualastronomy.org  
 
AVM: http://virtualastronomy.org/avm_metadata.php  
 
AVM Version 1.1: http://virtualastronomy.org/AVM_Version1.1May312008.pdf 
 
FITS Liberator: http://www.spacetelescope.org/projects/fits_liberator/index.html  
 
 
Technology needed 
 
• Internet browser & internet access 
• Adobe Photoshop or Adobe Bridge 
• Text editor 
• Admin permissions on your computer 
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STEP 1: Get XMP Panels for AVM 
 
1. Download and save the XMP panels (individual .txt files or .zip files) : 

http://www.virtualastronomy.org/avm_metadata.php#5   
 

2. Unzip file into a folder (location does not matter), you should have 5 txt files:  
• AVM-1-Creator.txt 
• AVM-2-Content.txt 
• AVM-3-Observation.txt 
• AVM-4-Coordinates.txt 
• AVM-5-Publisher.txt 

 
3. Copy & paste the 5 .txt files into the folder(s) specified below.  

 
For Mac OS X  - 2 locations (user dependent) 

• {Root Volume}/Library/Application Support/Adobe/XMP/Custom File Info Panels 
This path should work for all users. 

• {Home Directory}/Library/Application/Adobe/XMP/Custom File Info Panels 
This path is for a specific user. 

 
Windows (XP)* – 2 locations (user dependent) 

• \Program Files\Common Files\Adobe\XMP\Custom File Info Panels 
This path should work for all users. 

• \Documents and Settings\<user>\Application Data\Adobe\XMP\Custom File Info Panels 
This path is for a specific user. 
 

Windows Vista* – 1 location only 
• \Program Files\Common Files\Adobe\XMP\Custom File Info Panels 

 
By placing the XMP panels in these specific locations, they will be available in the File Info 
dialog box in both Adobe Photoshop and Adobe Bridge. Depending on your system, it may 
also make them available in other Adobe Creative Suite applications. 

 
For more detailed information from Adobe on XMP Panels, please see: 
http://www.adobe.com/products/xmp/custompanel.html  
 
Note: If you have FITS Liberator Version 2.1 installed, then you may have a slightly older 
version of the AVM XMP Panels. You can replace with this newer version of the File Info 
panels referenced above. 

 
* A common Windows error can occur. The user account you are logged in as needs to have 
Administrator privileges, else an administrator on that machine needs to change the 
permissions on the Adobe program folders to allow modification of the contents.  We have 
fewer problems with Vista finding/accessing the AVM panels if you change the Custom File 
Info Panels to have “Full” rights for all users on the machine. If you need to make this change, 
follow it by logging out and logging back in with your user account so the folder permission 
changes are recognized by Bridge/Photoshop. 
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STEP 2: Resolve WCS information 
 
If your images (JPEGs, TIFFs, etc.) do not have WCS information, you should try to resolve it. 
Images with WCS information can be placed into celestial sky grids and can be found with 
cone searches.  Images do not need WCS information to successfully submit to VAMP. 
 
We strongly recommend an online WCS resolving tool, Astrometry.net at 
http://www.astrometry.net. You can sign up to be an alpha tester here: 
http://astrometry.net/use.html.  Please contact Adrienne (agauthier@as.arizona.edu) if you are 
not given alpha tester status. 
 
If an image resolves on Astrometry.net, you will receive the WCS data on your image as 
information on a webpage and also as a FITS header. You can open the FITS header in most 
all text editor programs to extract the relevant information for the AVM. Please note that the 
FITS header will not open in FITS Liberator (it needs an actual image). 
 
Sample Astrometry.net Results Using Crimson Editor: 
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STEP 3a: Basic: Add AVM Tags 
 
To add AVM tags you can use either Adobe Photoshop or Adobe Bridge. The File Info Panels 
are the same. 
 
This is a general basic method for adding AVM to individual images.  Please see the Advanced 
Techniques for making templates and adding AVM to groups of images using fewer steps. 
 
1. Open the image file in Photoshop or navigate to the folder in Bridge and select the image to 

be your active file. 
 

2. Open the File Info Dialog by choosing from the top menu:  File > File Info  (same in 
Photoshop and bridge) 

 
3. The File Info XMP Panels come up, and you will see the 5 AVM panels (Astro Creator, 

Astro Content, Astro Observation, Astro Coordinates, Astro Publisher) listed on the left. 
These are the only 5 panels you should be using for the AVM. 

 
AVM tags on Creator panel 
Creator 
CreatorURL 
Contact.Name 
Contact.Email 
Contact.Telephone 
Contact.Address 
Contact.City 
Contact.StateProvince 
Contact.PostalCode 
Contact.Country 
Rights 
 
 
 
AVM tags on Content panel 
Title 
Headline 
Description 
Subject.Category 
Subject.Name 
Distance 
Distance Notes 
ReferenceURL 
Credit 
Date 
ID 
Type 
Image.ProductQuality 
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AVM tags on Observation panel 
Facility 
Instrument 
Spectral.ColorAssignment 
Spectral.Band 
Spectral.Bandpass 
Spectral.CentralWavelength 
Spectral.Notes 
Temporal.StartTime 
Temporal.IntegrationTime 
DatasetID 
 
 
 
 
AVM tags on Coordinates panel 
Spatial.CoordinateFrame 
Spatial.Equinox 
Spatial.ReferenceValue 
Spatial.ReferenceDimension 
Spatial.ReferencePixel 
Spatial.Scale 
Spatial.Rotation 
Spatial.CoordsystemProjection 
Spatial.Quality 
Spatial.Notes 
Spatial.FITSHeader 
Spatial.CDMatrix (deprecated tag) 
 
 

 
AVM tags on Publisher panel 
Publisher 
PublisherID 
ResourceID 
ResourceURL 
RelatedResources 
MetadataDate 
MetadataVersion (you should be tagging 
version 1.1) 
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4. Manually enter in the metadata for the fields. Please refer to the latest AVM document 

(Version 1.1) as a guide: http://virtualastronomy.org/avm_metadata.php    
5. Click OK when finished. Save the file to save the metadata entered.  The AVM is now 

written into the header of the image via the XMP standard. 
 
STEP 3b. Advanced Techniques 
 
These little gems may make your tagging work a little bit easier to tag image en mass, but 
certainly not as easy as having a standalone web application for creating/attaching XMP files 
to images. We hope to have a standalone XMP AVM application built soon. 
 
Cached Data 
 
Some of the AVM fields in the File Info Dialog will cache the last 15 entries for that field. If the 
field caches, it will have a triangle/arrow next to the data entry field. When you select the 
arrow, you will see the last 15 entered values. From there, you can select a value to auto-place 
in the field.  This cached data is user account dependent. 

 
If for some reason you’d like to clear this cache of values or fill it quickly you can manually edit 
the XML file. Only do this if you are familiar with XML and have a good editor program to auto-
format the page for easy readability. If you are familiar with XML files, once you open it you will 
be able to see where to edit/add/delete data.  
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Path of the file in Mac: 
{user}/Library/Preferences/Adobe/XMP/FileInfoLibPrefs.txt 
(or search for FileInfoLibPrefs.txt to find the location if not where expected) 
 
Path of the file in Windows XP: 
Documents and Settings\{user}\Application Data\Adobe\XMP\FileInfoLibPrefs.txt 
 
Path of the file in Windows Vista: 
Users\{user}\AppData\Roaming\Adobe\XMP\FileInfoLibPrefs.txt 
 
XMP Templates 
 
Many of the AVM tags will be common across your image collection: the Creator information, 
some of the Observation information, and once the VAMP Archive & Service is live also some 
of the Publisher information. You can create base “template xmp” files to apply to each image 
as a first step to tagging. 
 
There are a few ways to create XMP templates using Adobe tools. We suggest the following 
method as a starting place. 
 
In Bridge, do not use the Tools > Create Metadata Template widget. It does not display some 
of the AVM Panels correctly. If you choose to use the widget, be sure to note the differences to 
avoid errors. 
 
To create an XMP template in Photoshop/Bridge: 

 
1. Initially create a template by using the File Info dialog method. Complete only those 

fields that are common for your given set/subset of images. 
2. In the File Info navigation (left), choose Advanced at the bottom. 
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3. Choose Save/OK and name your XMP file. 
Photoshop - save in any location you like. 
Bridge - save in the following system folder: 

• Mac - {Home Directory}/Library/Application/Support/Adobe/XMP/Metadata 
Templates 

• Windows - C:\Users\{user}\AppData\Roaming\Adobe\XMP\Metadata 
Templates 

 
Note for Bridge: the XMP Templates, as far as we can see, are user-specific files as 
they reside under the user accounts in both Mac and Windows. 

To use an XMP Template in Photoshop: 

 
1. Open the image you want to apply metadata to.  
2. In the File Info navigation (left), choose Advanced at the bottom. 
3. Click Replace and choose the XMP file you want to use. This command completely 

replaces any existing metadata in the file with the metadata in the template. It will not 
delete existing metadata in the image if that particular field is empty in the template. 

4. Confirm application of template by checking the File Info. The metadata in the template 
should have transferred into the applicable AVM fields in File Info. 

 
 
To use an XMP Template in Bridge (2 methods) 
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Method 1 

1. Select the image(s) you want to apply the XMP Template to.   
2. In the File Info navigation (left), choose Advanced at the bottom. 
3. Click Replace and choose the XMP file you want to use. This command completely 

replaces any existing metadata in the file with the metadata in the template. It will not 
delete existing metadata in the image if that particular field is empty in the template. 

4. Confirm application of template by checking the File Info. The metadata in the template 
should have transferred into the applicable AVM fields in File Info. 

 
 
Method 2 

 
1. Select the image(s) you want to apply the XMP Template to  
2. From the top menu, choose Tools > Replace Metadata and then choose the template. 

The templates listed in this menu are from the special Adobe folder 
“Adobe>XMP>Metadata Templates” described above in ‘To create an XMP template in 
Photoshop/Bridge’.  This command completely replaces any existing metadata in the file 
with the metadata in the template. It will not delete existing metadata in the image if that 
particular field is empty in the template. 

3. Confirm application of template by checking the File Info. The metadata in the template 
should have transferred into the applicable AVM fields in File Info. 

 
Note: You can manually move XMP files into the Bridge “Metadata Templates” folder. They will 
show up in the list of templates.
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AVM Tagging Tool  
 
The alpha version of the AVM Tagging Tool is now online! This web form will create an XMP 
formatted XML file of the AVM tags. This file can then be imported to Adobe Photoshop or 
Bridge to attach the metadata to the image via the XMP standard. You will still need the AVM 
Panels (see STEP 1) to verify the metadata once in Adobe Photoshop/Bridge. Without the 
panels, you will not be able to review the tags from within the program(s).  
 
Please find the AVM Tagging Tool here: http://www.virtualastronomy.org/avmwebtool/  
 
The tool works best with Mozilla Firefox or Safari web browsers. 
 
Suggested Workflow 
 

1. Enter the metadata into the web-based form. Pay special attention to the Date tag and 
the Temporal.StartTime tag and follow the required format for the web form. Once 
imported into Photoshop/Bridge, these fields will change over to your “local date 
settings” format. 

2. If you have list-ordered fields (Facility, Instrument, Spectral,ColorAssignment, 
Spectral.Band, Spectral.Bandpass, Spectral.CentralWavelength, Temporal.StartTime, 
Temporal.IntegrationTime and DatasetID) then you can add fields for the number of 
ordered items in your list at the beginning of the Observation area by using the +/- 
button. 

3. When you have completed the form (not all fields needs to be filled out), name your file 
in the File box and then click “Convert to XMP”. You will be prompted to save the xml 
file. 

4. Open Bridge or Photoshop, and following directions in STEP3b Advanced Techniques 
of this guide for applying a metadata template.  You may need to allow “all file types” to 
be seen in the file selector, this is an XML file not an XMP file. However, 
Photoshop/Bridge will read it in correctly as a template file. 
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General Tagging Notes 
 
In this section you will find user experience notes on tagging. Common issues, solutions and 
work-arounds are placed here. If in your experience of tagging images you have words of 
wisdom to add or wish to report buggy software and modifications to the proposed methods, 
please email Adrienne (agauthier@as.arizona.edu) so that they can be added to the next 
version of our guide and shared live on our website. 
 
Helpful Hints and Cautions 
 

• Some tags fields can have multiple metadata entries. For multiple entries, please use a 
semicolon    ;      as a delimiter between tags 

• Tags that have a controlled vocabulary (see Chart 1. Controlled Vocabulary Cheat-
Sheet): 

o Subject.Category  
o Type 
o Image.ProductQuality 
o Spectral.ColorAssignment 
o Spectral.Band 
o Spatial.CoordinateFrame 
o Spatial.CoordinateSystemProjection 
o Spatial.Quality 

• Controlled vocabulary tags that have only 1 metadata entry have pull-down menus with 
the vocabulary listed. 

• Controlled vocabulary tags that can have multiple metadata entries (Subject.Category, 
Spectral.ColorAssignment, Spectral.Band) do not have pull down menus in 
Photoshop/Bridge and the user needs to enter the controlled vocabulary terms manually, 
separated by a semicolon.  The controlled vocabulary terms for 
Spectral.ColorAssignment and Spectral.Band are listed under the data entry field.   
Watch your typos! 

• Enter the Subject.Category tags using the designated first letter and number system. 
Please see Chart 2. Subject.Category Cheat-sheet or Section 5.1 Subject.Category: 
Astronomical Object Taxonomy of the latest AVM Document, 
http://virtualastronomy.org/avm_metadata.php 
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Issues with Bridge 
 
1. Bridge has a Metadata panel, seen in this screenshot on the lower right side. Unfortunately, 
Bridge does not read in the AVM XMP Panels completely. Some fields are missing, controlled 
vocabularies are not presented, and it does not match the metadata that appears in the File 
Info dialog box.  We suggest that you do not use the Bridge Metadata panel to enter/modify 
metadata. 
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2. This same issue as above occurs with the Tools>Create Metadata Template widget. Many 
of the fields are missing, further the controlled vocabularies are missing. 
 

 
 
Issues with Photoshop 
 
There are no issues with Photoshop to report at this time. 
 
 
Need Assistance? 
 
Please contact Adrienne at agauthier@as.arizona.edu if you have any 
issues/concerns/suggestions for tagging with the AVM. 
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Chart 1. Controlled Vocabulary Cheat-sheet 
Image.ProductQuality Good – Clean, publication-ready image 

Moderate – Some flaws in the image, but of good quality 
Poor – Degraded quality; significant artifacts, but still acceptable for 
reference 

Spatial.CoordinateFrame ICRS – celestial epoch-independent system 
FK5 – celestial, default J2000 epoch 
FK4 – celestial, default B1950 epoch 
ECL – ecliptic coordinates 
GAL – galactic coordinates 
SGAL – supergalactic coordinates 

Spatial.CoordinateSystemProjection TAN – tangent 
SIN – sinusoidal 
ARC – arc sky 
AIT – AITOFF full-sky 
CAR – Plate –Careé (rectilinear coordinates) 
CEA – cylindrical equal-area 

Spatial.Quality Full – Verified full WCS information (though may exclude CD matrix) 
Position – Spatial.ReferenceValue describes a coordinate contained 
somewhere within the image; other WCS info is approximate or 
unreliable 

Radio λ ≥ 10 mm,  ν ≥ 30 GHz 

Millimeter 0.1 mm ≤ λ ≤ 10 mm   
3000 GHz ≥ ν ≥ 30 GHz 

Infrared 1 μ ≤ λ ≤ 100 μ 

Optical 0.3 μ ≤ λ ≤ 1 μ 
300 nm ≤ λ ≤ 1000 nm 
3000 Å ≤ λ ≤  10000 Å 

Ultraviolet 0.01 μ ≤ λ ≤  0.3 μ 
100 Å ≤ λ ≤  3000 Å 
1.2 eV ≤ E ≤120 eV 

X-ray 0.12 keV ≤ E ≤ 120 keV 

Spectral.Band 
 

Gamma Ray E ≥ 120 keV 

Purple 
Blue 
Cyan 
Green 

Yellow 
Orange 
Red 
Magenta 

Spectral.ColorAssignment 

Grayscale – for single-channel image 
Pseudocolor – for single channel image with color mapped to intensity

Subject.Category see Chart 2. Subject.Category Summary   

Type Observation – An astronomical image rendered from telescopic data.
Artwork – Artists’ renderings of astronomical phenomena or objects. 
Photographic – Photos from film/digital cameras. 
Planetary – Images from planetary orbiters/landers. 
Simulation – Digital renderings of simulated/computed datasets. 
Chart – A graph or diagram based on data 
Collage – Any image that has multiple elements and/or image types. 
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Chart 2. Subject.Category Cheat-sheet 

 
Top Level Hierarchy ………………………………………… 
 
A. Solar System: local to our solar system 
B. Milky Way: contained within the Milky Way galaxy 
C. Local Universe: current “era” of the universe  
D. Early Universe: era of galaxy formation and before 
E. Unspecified: for generic instance of subject 

 
1. Planet…………………………………………………….                                                                               

1.1. [Type] 
1.1.1. Terrestrial 
1.1.2. Gas Giant 

1.2.  [Feature] 
1.2.1. Surface 

1.2.1.1. Mountain 
1.2.1.2. Canyon 
1.2.1.3. Volcanic 
1.2.1.4. Impact 
1.2.1.5. Erosion 
1.2.1.6. Liquid 
1.2.1.7. Ice 

1.2.2. Atmosphere 
1.2.2.1. Cloud 
1.2.2.2. Storm 
1.2.2.3. Belt 
1.2.2.4. Aurora 

1.3. [Special Cases] 
1.3.1. Transiting 
1.3.2. Hot Jupiter 
1.3.3. Pulsar planet 

1.4. Satellite 
1.4.1. [Feature] 

1.4.1.1. Surface 
1.4.1.1.1. Mountain 
1.4.1.1.2. Canyon 
1.4.1.1.3. Volcanic 
1.4.1.1.4. Impact 
1.4.1.1.5. Erosion 
1.4.1.1.6. Liquid 
1.4.1.1.7. Ice 

1.4.1.2. Atmosphere 
1.5. Ring 

2. Interplanetary Body…………………………………… 
2.1. Dwarf planet 
2.2. Comet 

2.2.1. Nucleus 
2.2.2. Coma 
2.2.3. Tail 

2.2.3.1. Dust 
2.2.3.2. Gas 

2.3. Asteroid 
2.4. Meteoroid 

3. Star ……………………………………………………… 
3.1. [Evolutionary Stage] 

3.1.1. Protostar 
3.1.2. Young Stellar Object 
3.1.3. Main Sequence 
3.1.4. Red Giant 
3.1.5. Red Supergiant 
3.1.6. Blue Supergiant 
3.1.7. White Dwarf 

3.1.8. Supernova 
3.1.9. Neutron Star 

3.1.9.1. Pulsar 
3.1.9.2. Magnetar 

3.1.10. Black Hole 
3.2. [Type] 

3.2.1. Variable 
3.2.1.1. Pulsating 
3.2.1.2. Irregular 
3.2.1.3. Eclipsing 
3.2.1.4. Flare Star 
3.2.1.5. Nova 

3.2.2. Carbon 
3.2.3. Brown Dwarf 
3.2.4. Wolf-Rayet 
3.2.5. Blue Straggler 
3.2.6. Exotic 

3.3.  [Spectral Type] 
3.3.1. O 
3.3.2. B 
3.3.3. A 
3.3.4. F 
3.3.5. G 
3.3.6. K 
3.3.7. M 
3.3.8. L 
3.3.9. T 

3.4. [Population] 
3.4.1. I 
3.4.2. II 
3.4.3. III 

3.5.  [Feature] 
3.5.1. Photosphere 

3.5.1.1. Granulation 
3.5.1.2. Sunspot 

3.5.2. Chromosphere 
3.5.2.1. Flare 
3.5.2.2. Facula 

3.5.3. Corona 
3.5.3.1. Prominence 

3.6. [Grouping] 
3.6.1. Binary 
3.6.2. Triple 
3.6.3. Multiple 
3.6.4. Cluster 

3.6.4.1. Open 
3.6.4.2. Globular 

3.7. Circumstellar Material 
3.7.1. Planetary System 
3.7.2. Disk 

3.7.2.1. Protoplanetary 
3.7.2.2. Accretion 
3.7.2.3. Debris 

3.7.3. Outflow 
3.7.3.1. Solar Wind 
3.7.3.2. Coronal Mass Ejection 

4. Nebula…………………………………………………… 
4.1. [Type] 

4.1.1. Interstellar Medium 
4.1.2. Star Formation 
4.1.3. Planetary 
4.1.4. Supernova Remnant 
4.1.5. Jet 



AVM Users Guide for Tagging Imagery    Page 19

4.2.  [Appearance] 
4.2.1. Emission 

4.2.1.1. H II Region 
4.2.2. Reflection 

4.2.2.1. Light Echo 
4.2.3. Dark 

4.2.3.1. Molecular Cloud 
4.2.3.2. Bok Globule 
4.2.3.3. Proplyd 

5. Galaxy…………………………………………………… 
5.1. [Type] 

5.1.1. Spiral 
5.1.2. Barred 
5.1.3. Lenticular 
5.1.4. Elliptical 
5.1.5. Ring 
5.1.6. Irregular 
5.1.7. Interacting 
5.1.8. Gravitationally Lensed 

5.2. [Size] 
5.2.1. Giant 
5.2.2. Dwarf 

5.3. [Activity] 
5.3.1. Normal 
5.3.2. AGN 

5.3.2.1. Quasar 
5.3.2.2. Seyfert 
5.3.2.3. Blazar 
5.3.2.4. Liner 

5.3.3. Starburst 
5.3.4. Ultraluminous 

5.4. [Component] 
5.4.1. Bulge 
5.4.2. Bar 
5.4.3. Disk 
5.4.4. Halo 
5.4.5. Ring 
5.4.6. Central Black Hole 
5.4.7. Spiral Arm 
5.4.8. Dust Lane 
5.4.9. Center/Core 

5.5.  [Grouping] 
5.5.1. Pair 
5.5.2. Multiple 
5.5.3. Cluster 
5.5.4. Supercluster 

6. Cosmology …………………………………………….. 
6.1. [Morphology] 

6.1.1. Deep Field 
6.1.2. Large-Scale Structure 
6.1.3. Cosmic Background 

6.2.  [Phenomenon] 
6.2.1. Lensing 
6.2.2. Gamma Ray Burst 
6.2.3. Dark Matter 

7. Sky Phenomenon          ……………………………… 
7.1. Night Sky 

7.1.1. Constellation 
7.1.2. Asterism 
7.1.3. Milky Way 

7.1.4. Trail 
7.1.4.1. Meteor 
7.1.4.2. Star 
7.1.4.3. Satellite 

7.1.5. Zodiacal Light 
7.1.5.1. Gegenschein 

7.1.6. Night glow 
7.2. Eclipse 

7.2.1. Solar  
7.2.1.1. Total 
7.2.1.2. Partial 
7.2.1.3. Annular 

7.2.2. Lunar  
7.2.2.1. Total 
7.2.2.2. Partial 
7.2.2.3. Penumbral 

7.2.3. Occultation 
7.2.4. Transit 

7.3. Light Phenomenon 
7.3.1. Sunrise-Sunset 

7.3.1.1. Green flash 
7.3.1.2. Refractive Distortion 
7.3.1.3. Sun Pillar 

7.3.2. Cloud 
7.3.2.1. Iridescent 
7.3.2.2. Noctilucent 
7.3.2.3. Nacreous 
7.3.2.4. Corona 
7.3.2.5. Glory 

7.3.3. Rainbow 
7.3.3.1. Moonbow 
7.3.3.2. Fogbow 

7.3.4. Halo 
7.3.4.1. Circle 
7.3.4.2. Parhelia 
7.3.4.3. Arc 

7.3.5. Ray-Shadow 
7.3.5.1. Crepuscular ray 
7.3.5.2. Anti-crepuscular ray 
7.3.5.3. Earth shadow 

7.3.6. Lightning 
7.3.7. Aurora 

8. Technology ……………………………………………. 
8.1. Observatory 

8.1.1. Facility 
8.1.2. Telescope 
8.1.3. Instrument 
8.1.4. Detector 

8.2. Spacecraft 
8.2.1. Orbiter 
8.2.2. Probe 
8.2.3. Lander 
8.2.4. Manned 
8.2.5. Launch Vehicle 

9. People. .                                                                 . . . .                    
       9.1 Scientist 
       9.2 Astronaut 
       9.3 Other/General 
  



AVM Users Guide for Tagging Imagery    Page 20

Chart 3. Sample Metadata 
 
 
AVM Tag Name Format Example 
3.1 Creator Metadata 
Creator string Spitzer Science Center 
CreatorURL URL http://www.spitzer.caltech.edu 
Contact.Name string, list R. Hurt 
Contact.Email string, list example@ipac.caltech.edu 
Contact.Telephone string, list 555-555-5555 
Contact.Address string 1200 E. California Blvd. 
Contact.City string Pasadena 
Contact.StateProvince string California 
Contact.PostalCode string 91125 
Contact.Country string USA 
Rights string Public Domain 

3.2 Content Metadata 
Title string M 82 
Headline string The galaxy M82 is seen across the spectrum from 

X-rays to infrared light. This combined view is from 
NASA's Chandra, Hubble, and Spitzer telescopes. 

Description string NASA's Spitzer, Hubble, and Chandra space 
observatories teamed up to create this multi-
wavelength, false-colored view of the M82 galaxy. 
High energy particles appear as blue, stars as 
green, dust as red. 

Subject.Category string-CV, list C.5.1.6;C.5.3.3 
Subject.Name string, list M 82; Messier 82; NGC 3034; Cigar Galaxy 
Distance float, list(2) 11700000; 0.000677 
Distance.Notes string Light years from PI; redshift from NED 
ReferenceURL URL http://gallery.spitzer.caltech.edu/Imagegallery/image

.php?image_name=sig06-010 
Credit string NASA/JPL-

Caltech/STScI/CXC/UofA/ESA/AURA/JHU 
Date date 2007-04-24 
ID string sig06-010 
Type string-CV Observation 
Image.ProductQuality string-CV Good 

3.3 Observation Metadata 
Facility string, list(s) Chandra; Hubble; Hubble; Spitzer 
Instrument string, list(s) ACIS; ACS; ACS; IRAC 
Spectral.ColorAssignment string-CV, 

list(s) 
Blue; Green; Orange; Red 

Spectral.Band string-CV, 
list(s) 

X-ray; Optical; Optical; Infrared 

Spectral.Bandpass string, list(s) -;B;R;mid-infrared 
Spectral.CentralWavelength float, list(s) 0.5;440;700;8000 
Spectral.Notes string X-ray bandpass wavelengths are approximate. 

Temporal.StartTime date, list(s) -; 2005-02-05; 2005-02-05; 2004-07-03T12:00 

Temporal.IntegrationTime float, list(s) -; -; -; 240 
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DatasetID string, list(s) a1;a2;a3;a4 

3.4 Coordinate Metadata 
Spatial.CoordinateFrame string-CV ICRS 
Spatial.Equinox string 2000 
Spatial.ReferenceValue float, list(2) 149.11051168; 69.7053749827 
Spatial.ReferenceDimension float, list(2) 4299; 3490 
Spatial.ReferencePixel float, list(2) 922.146820068; 1153.85690308 
Spatial.Scale float, list(2) -4.1635027032331E-05; 4.1635027032331E-05 
Spatial.Rotation float 49.93606563 
Spatial.CoordsystemProjection string-CV TAN 
Spatial.Quality string-CV Full 
Spatial.Notes string FOV: 10.74 x 8.72 arcminutes; Ref coordinate: 

9h56m26.52s 69d42m19.35s; derived from 
astrometry.net file sig06-010.fits 

Spatial.FITSheader string CRVAL1  =               6.3856  CRVAL2  =              
64.1784  RADESYS = 'ICRS    '           EQUINOX =     
2000.   CTYPE1  = 'RA---TAN'        CTYPE2  = 
'DEC--TAN'    CRPIX1  =                 214.   CRPIX2  
=                 138.  

Spatial.CDMatrix (deprecated) float, list(4)  

3.5 Publisher Metadata 
Publisher string Spitzer Space Telescope 
PublisherID string vamp://spitzer 
ResourceID string sig05-010_jpg_sm 
ResourceURL URL http://ipac.jpl.nasa.gov/media_images/sig06-010.tif 
RelatedResources list vamp://spitzer/sig05-010; vamp://spitzer/sig05-010 
MetadataDate date 2008-05-09 
MetadataVersion string 1.1 

3.6 File Metadata 
File.Type string-CV TIFF 
File.Dimension float, list(2) 4299; 3490 
File.Size float, list(2) 18237 
File.BitDepth float 24 
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Tutorial 1: Scaling WCS Information 
 
You will need to scale your WCS information if you have changed the image resolution/dimensions from that of 
the original image that you have WCS information for. The scaled image must have the same image width to 
height ratio as the original and must not have been cropped. If it does not have the same ratio or has been 
cropped, you will need to resolve new WCS information for that image. 
 
The following WCS information needs to be recalculated: 
A. Spatial.ReferencePixel (FITS: CRPIX1, CRPIX2) 
B. Spatial.Scale (FITS: CDELT1, CDELT2) 
C. Spatial.CDMatrix (FITS: CD1_1, CD1_2, CD2_1, CD2_2) 
 
Variable Key: 
 
xdimold  = dimensions in pixels on the x-axis from original image 
ydimold  = dimensions in pixels on the y-axis from original image 
 
xdimnew  = newly scaled x dimensions in pixels 
ydimnew  = newly scaled y dimensions in pixels 
 
xdeg  = dimension of the image in degrees along the x-axis 
ydeg  = dimension of the image in degrees along the y-axis 
 
xrefold  = x reference pixel position from original image (CRPIX1) 
yrefold  = y reference pixel position from original image (CRPIX2) 
 
xrefnew  = newly scaled x reference pixel position 
yrefnew  = newly scaled y reference pixel position 
 
xscaleold  = original image scale in degrees/pixel along the x-axis (CDELT1) 
yscaleold  = original image scale in degrees/pixel along the y-axis (CDELT2) 
 
xscalenew  = original image scale in degrees/pixel along the x-axis 
yscalenew  = original image scale in degrees/pixel along the y-axis 
 
Sample Data: 
WCS Data Old Value from Original Image New Value from Scaled Image 

Spatial.ReferenceDimension (x) 3857 506 

Spatial.ReferenceDimension (y) 7804 1024 

Spatial.ReferencePixel (CRPIX1) 1929.5 253.13119004 

Spatial.ReferencePixel (CRPIX2) 3903 512.13121476 

Spatial.Scale (CDELT1) 1.38621371859793e-05 0.000105664551633 

Spatial.Scale (CDELT2) 1.38824518656616e-05 0.000105799467148 

CD1_1 1.66090206e-06 1.26602751886e-05 

CD1_2 -1.37835696e-05 -0.000105045876131 

CD2_1 -1.37622764e-05 -0.000104903359832 

CD2_2 -1.65398878e-06 -1.26052035538e-05 



AVM Users Guide for Tagging Imagery    Page 23

A. To scale Spatial.ReferencePixel values 
 
To adjust CRPIX1 and CRPIX 2 use a proportion: 
 
 
 
 
 
 
 
 
 
 
 
 
 
B. To scale Spatial.Scale values 
 
To adjust CDELT1 and CDELT2 first the size of the image in degrees must be found, then the new scale in 
degrees/pixel can be calculated. 
 
  
 
 
 
 
    
 
 
 
 
 
 
 
 
 
C. To scale the CD Matrix (CD1_1, CD1_2, CD2_1, CD2_2) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

xdimold 

xrefold 

xdimnew 

xrefnew = CRPIX1-scaled 
Solve for xrefnew 

ydimold 

yrefold 

ydimnew 

yrefnew 
= CRPIX2-scaled 

Solve for yrefnew 

(xscaleold) (xdimold) 

(yscaleold) (ydimold) 

xdeg =  

ydeg =  

xscalenew =  
xdeg 

xdimnew 

yscalenew =  
ydeg 

ydimnew 

CD1_1new =  CD1_1old  
xscaleold 

xscalenew ( ) CD1_2new =  - CD1_2old  yscaleold 

yscalenew ( )
CD2_2new =  CD2_2old  

yscaleold 

yscalenew ( )CD2_1new =  CD2_1old  xscaleold 

xscalenew ( )


